
A short animation

et's make a short animation. Here are the
names of the things you’ll be using this time
around — you can find a complete chart at

the end of this chapter.

1. Get a word into Pixar Typestry and position it at
the left side of the project window.

2. If the Score window’s not showing, select Score
from the Windows menu, or click on the Score icon
in the Toolbar. Make the Score window wide
enough to see the rightmost animation bracket.

3. Drag the animation bracket to the “31” tick
mark.

4. In the Score window, drag the pose nib (little
black diamond box to the right of the double line)
over to the tick mark just before the “31” tick mark.

You’ve just set the length of the animation to 30
frames, or one second.

5. Double-click on the pose nib you created. This
moves the Time Marker to where the nib is, letting
you set what’s happening at the time represented by
the position of the nib.

6. Move the text to the right side of the project
window. Now the text will start out at the left and
end up at the right.

Remember this: move the Time Marker first, then
move the text. Whenever you do something in the
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project window, you do it only at the time repre-
sented by the Time Marker.

7. Move the Time Marker about halfway in
between the two nibs.

8. In the project window, move the word to the
bottom of the screen. You’ll see a new nib appear
on the word’s timeline.

• Wherever you see a nib on an object's timeline
it means “the object has an appointment at this time
to be somewhere.”

9. Using the Rotate tool, rotate the word a bunch.

If the word gets in a weird position, just use Undo,
or Reset Orientation from the Edit menu.

10. Click on the Play button at the top of the Score
window. You should see a box moving around the
screen where the word would be, twirling as it
moves down and across the screen from one side
to the other, over and over. Click anywhere to stop
the animation.

That's it. It would be a simple step to render all the
frames and make an AVI movie, but we just wanted
to show you how easy it is to set up a simple anima-
tion.

Now if you're the type who's ready to plunge ahead
expecting to be the next Walt Disney without fur-
ther ado, hang on just a little while longer.

So, class, what have we learned in our introductory
lesson?

• Use the Time Marker to show you where you
are in time.

• Using one of the tools on an object freezes it in
space (in the project window), and in time (as a nib
in the Score window).

• Use the Play button to play a rough version of
an animation.

What you did was to pick a few points in time, and
then determine where an object should be at those
times. Typestry then calculated where the object
should be in between those times. This is called
“tweening” (or “interpolation” if that makes you feel
better).

As you can see, you can create simple animations of
your text with the controls in the Score window. A
finished animation consists of a series of rendered
frames, which can be used either as the raw material
for an AVI movie, video, or for some other anima-
tion software.
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The Pose

Each pose nib (little black box) in an object's time-
line implies four things about the object, corre-
sponding to the four tools that allow you to change
an object:

• position

• orientation

• size

• slant (skew)

These four characteristics define an object's pose.
The way poses change over time defines an anima-
tion.

• In the Score window, each pose nib on a time-
line represents a pose.

The path an animated object takes is defined by its
position in some number of poses. Let's say you
have five poses, equally spaced in time, that look like
the ones above.

The object will follow a path that
passes though all five of the object's
poses. The shape of this path is
determined in a popup menu. To
get this menu, click and hold on a
pose nib.
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Linear. This moves
the object in a straight
line from pose to pose,
creating sharp corners
where it changes direc-
tion.

Smooth. This moves
the object in a tight
curve as it changes
direction. The shape of
the curve is affected
both by where the
object is coming from,
and by where it's
going.

The four bottom items on the menu control not the
shape of the path, but an object’s speed near a pose.

No Ease. This moves the object at a constant
speed as it passes through the pose.

Ease In. This decelerates the object as it arrives at
the pose. At the moment of the pose it speeds up
to its previous speed (before the deceleration). As it
leaves the pose, the object moves at a constant
speed. This is often useful when an object arrives
somewhere (so you never see the speed jump as it
leaves).

Ease Out. This moves the object at a constant
speed approaching the pose. At the moment of the
pose the object slows down, and is accelerated back
to its previous speed as it leaves the pose. This is
often useful when an object is leaving somewhere
(so you never see the speed jump as it arrives).

Ease In&Out. This decelerates the object as it
arrives at the pose, and accelerates it leaving the
pose.

Each pose type has its own nib shape. Below, the
nibs shown are, from left to right: No Ease, Ease
Out, Ease In&Out, Ease In and No Ease.
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When would you want to ease in or out? Well, eas-
ing is often perceived as a more “natural” motion
for many things. It's impossible, for example, for
things to reach some speed without accelerating to
get there. But, as usual, in computer graphics the
impossible is not only possible, it's all too easy.
Similarly, unless you're trying for a crash effect,
decelerating to a stop is often desirable. However,
there is a place for everything — if you're simulating
the billiard ball effect, you'll want no easing and lin-
ear motion. For this situation, those settings will
make for a more “natural” motion. Be sure to play
around with different types of motion when you
create your animations. They can add subtle effects
that heighten the sense of motion.

While it's quite easy to make an object move in
Typestry just by changing its position in some poses,
you can also change the other characteristics of the
object's pose. Resizing it in another pose will make it
grow or shrink, and rotating it will make it twirl. In
any pose you can change any or all of the object's
characteristics.

Don’t forget that since you can move a light’s posi-
tion in the Lights window, you can animate lights,
too. You can make them track objects, or make the
sun seem to rise.

• Note: Typestry provides a good way to get start-
ed doing simple animations. If you'd like to do fanci-

er animations, you may need to look at packages
designed specifically for animation. Also, if you
would like to get an animation into video, you'll have
to think about a number of issues Typestry was not
intended to address, for example NTSC vs. PAL for-
mats, NTSC “forbidden” colors, and so on.

Before we move on, there’s something you must
remember as you start to make animations, or you
will surely curse yourself. You must first move the
Time Marker to where you want it, and then set the
object’s pose (move the object). So now repeat this
mantra:

• “First move the Time Marker, then set the pose.
First move the Time Marker, then set the pose.”

A common mistake to make when doing animation
in Typestry is to move something, then move it
somewhere else, then somewhere else, all the while
leaving the Time Marker in one place. Nothing will
animate unless an object changes position over time.
The way to go to a new time is to move the Time
Marker, or to select Jump Forward from the Motion
menu.

Jump Forward skips ahead by the number of frames
set in the Animation Settings dialog, available by
selecting Animation Settings from the Motion menu.
Naturally, you can go back the same number of
frames by using Jump Backward, also under the
Motion menu.
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Poses and groups

As we said before, an object's four characteristics
define its pose. Well, the fundamental thing to
understand about a pose is that it defines a relation-
ship.

Let’s look at the characteristic of position. Perhaps
the most obvious way of describing a word’s posi-
tion is by saying something like, “It’s in the middle of
the window.” But if we’re talking about a letter in a
word, you might say something like, “It’s at the end
of the word.” In the first case the description was
relative to the window; in the second it was relative
to the word. This is exactly analogous to the way
Typestry keeps track of things.

Now let’s do a little experiment. This will prove that:

• Objects that are members of a group move rela-
tive to the group.

• Objects that are not members of a group move
relative to the window. (For example, a word that’s
the only group in the scene isn’t a member of
another group, so it moves relative to the window.)

1. Get the word “test” into Typestry, near the mid-
dle of a squarish project window.
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2. With the Score window showing, move the
Time Marker about 3/4 of the way to the “31”
mark, then move the word down to the bottom of
the project window.

3. Run the animation by clicking on the Play button
at the top of the Score window. (Make sure the ani-
mation brackets are placed appropriately.) You
should see the word move from its initial position
down to the bottom of the window.

4. Now open the word group by clicking on its
folder icon in the Score window.

Notice that although you created a new pose for
the group, there are no new poses for the individual
letters. You don't see new poses for the letters
because their position, orientation, etc. relative to the
group haven't changed — they’re all still in their
proper place within the word.

5. Move the Time Marker most of the way back to
the first frame.

6. In the project window, select the “s” by double-
clicking on it, and move it up to the top of the win-
dow.
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7. Run the animation again. As the word moves
down you should see the box representing the “s”
shoot upwards, then drift down as the rest of the
word does.

Rather than thinking you moved the letter higher in
the window, since it's a member of a group you
should think that you made that part of the group
higher than the rest of the group. You changed the
letter’s position relative to the group, not relative to
the window. That’s why when the letter finished its
own motion, the word’s motion affected it.

If the word were twirling in place instead of falling,
the “s” would be twirling too, of course — it’s part
of the word. It would just be higher than the rest of
the word.

Leave this project window as it is — you’ll need it in
a minute.

So, to review:

• The characteristics (pose) of an object that is not
a member of a group are relative to the 3-dimen-
sional “space” inside your project window.

• The characteristics of an object that is a member
of a group (e.g., a letter in a word) are relative to
those of its group.

Grouping and ungrouping

Now that you know about the motion of groups
and their elements, the next step is to realize that
you can:

• separate an element from its group to allow the
element to move independently;

• control two objects at once by combining them
into a group.

In addition to the above, in this section you’ll learn a
handy trick:

• how to delay movements

So, what if we wanted the “s” to stay at the top of
the window? Well, we could just move it there in
the very last pose, but how could we be sure it was-
n’t just a little too high or too low in that pose?
Instead, let’s just remove it from the word and treat
it as a separate object:

1. Take it out of the word group by dragging it (by
its gray drag bar) up above the “test” group in the
Score window. Now there are two objects at the
highest level: the “s” and the “tet.”
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2. Run the animation.

The “s” moves up and stays there. Its movement is
no longer relative to the rest of the word. But if we
ever want the “s” to be part of the word again
we’re hosed — there’s no connection between the
two. So let’s say we want to twirl the whole word
when the “te t” reaches the bottom. What do we
do?

Here’s where the tricky part comes in. We can’t just
stick the “s” in the word again, because it will fall
along with the word, after it reaches the top. We
already know that. The trick is to have everything, all
the letters, really be parts of one object again —
one group. All we need to do is create a new group
that contains both the “s” and the “tet” group, and
twirl that:

3. In the Score window, select the “s,” then select
Group from the Edit menu. This creates a group
with just the “s” in it.

4. Move the “tet” group into the new group by
slowly dragging it to the right, and slightly upward
until the purple cursor is under the drag bar of the
“s.” (If you’d like to review how to reorganize
groups, and the behavior of the cursor, see the sec-
tion on “Using the tree” in the Group Therapy chap-
ter.)

5. Move the Time Marker all the way to the “31”
mark.

6. In the project window click on some empty
space to ensure that you have nothing selected, then
click on any of the letters to select the new group
and twirl it some using one of the Rotate tools.

7. Run the animation again.

Uh-oh! We wanted the group to twirl after the
“te t” reached the bottom, not while it was on its
way there. We need to keep the group stationary
until the right time. How do we delay it’s rotation
until later?

Remember, the group isn’t moving relative to any-
thing but the space in the window. And at time 0
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the group was just the way we want it to be when
the rest of the word reaches the bottom of the win-
dow. All we need to do is copy that first pose over
to the time when the rest of the word reaches the
bottom of the window. That will prevent the group
from twirling until that point:

8. In the Score window, hold the Ctrl key down
and drag the group’s initial pose even with the last
pose of the “tet” group. This makes a copy of that
pose.

9. Run the animation again.

So don’t forget, when you need to change relation-
ships for a while, ungroup an element, and then cre-
ate a group that contains both the element and old
group.

Save or close your project now.

And now for the “really big shew...”

Ok, now that you’re warmed up, let’s try making a
more complete animation using a combination of
tools and poses. Then you’ll really be the next Walt
Disney. First, get a new project window and make it
wider than it is tall. Then:

1. Click on the Text tool to bring up the Details
window, and type in and Add the word “Fly.” 

2. Use the Scale tool to make the word about half
an inch high on your screen.

Let’s have the large-scale movement be from upper
left to middle bottom to upper right. And let’s have
the word get bigger as it nears the bottom. After all,
you can have more than one kind of motion at
once:

3. Using the Move tool, move the word into the
upper left quarter of the window.

4. In the Score window, move the Time Marker
halfway to the “31” tick mark.

5. In the project window, scale the word so it’s
about twice as big, and move it to the bottom in the
middle of the window.
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6. Now move the Time Marker all the way to the
“31” mark, and move the word into the upper right
quarter of the window.

7. Run the animation by selecting Run Animation
from the Motion menu. You should see the word
move down as it grows, and then move up to the
upper right.

You with me so far? Good. Now let’s take advan-
tage of the ability to move things at different levels
and overlay some movement by individual letters.
We’ll have the “y” get lost and catch up with the
word, while the “F” twirls on its way down. Let’s do
the “F” first:

1. In the Score window, open up the word by click-
ing on its folder. Now you can see the timelines for
the individual letters.

2. Slide the Time Marker halfway between the
word’s first and second poses.

3. In the project window get the Rotate tool and
double-click on the “F.” This selects the letter.

4. Click on it using the second mouse button. This
brings up the Rotate dialog. Type “180” in the dialog
and click on the left-most axis, then on OK. This
rotates the letter forward so it’s upside down.

To get the “F” to twirl the rest of the way we could
rotate it 180° again when it reaches the bottom
(where the word’s middle pose is). But there’s a
more elegant way. Did you notice that what we
want is for the letter to have the same relationship it
had with the rest of the group at the beginning —
same position, size, and orientation? I knew you did.
Same relationship = same pose:

5. In the Score window select the “F’s” first pose.
Holding down the Ctrl key, drag the pose directly
underneath the word’s middle pose. This copies the
pose, restoring the letter’s original (right-side up)
relationship with the word.

Run the animation (Ctrl-L) to check this out. Now
for that poor “y.” Like the “F,” let’s have the “y” be
back to normal by the time it reaches the bottom:

6. Drag the “y’s” initial pose out to, oh, just before
the word’s middle pose. This way it will rejoin the
word just before it reaches bottom.

7. Set the Time Marker about where the “F’s” mid-
dle pose is.

8. In the project window use the Move tool to
move the “y” near to the upper left corner of the
window.
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9. Move the Time Marker so it’s halfway between
the “y’s” last two poses, and move the “y” so it’s just
above and to the right of the “l.”

Run the animation again to view the fruits of your
labor. And now for the finishing touch. After the
word arrives at the upper right, let’s have the “y” fall
on the floor. We’ll build in a pause before the fall for
dramatic effect:

1. The final position of the “y” will be on the floor.
This is the end of the animation. Since it’s some time
after the arrival of the word in the upper right, set
the Time Marker about halfway between the “31”
and “61” tick marks.

2. Move the “y” straight down (using the Shift key
to constrain its movement) to the bottom of the
window.

3. Using the Rotate tool and the second mouse
button, rotate the “y” forward 90° (use the left-
most axis in the Rotate dialog again).

4. Now take a look at the scene from the Left
View — pull down the View menu, then select
From Left (or Ctrl-2).

(Don’t let those camera views go begging to be
used. Use them with abandon!)

5. The letter is underneath the word. This is
because an object rotates around its center, not its
base.

6. Using the Move tool move the letter to the right
so it’s just barely out from under the rest of the
word. You’ll have to sort of eyeball this. (But you
might be able to use the Top View to check it —
Ctrl-3.) When you’re done go back to the Front
View (Ctrl-1).

Run the animation again.

Surprise! We forgot to make sure that the “y”
doesn’t start to fall until after the word arrives on
the right. Instead, it starts when it rejoins the word
halfway through. What to do, oh what to do?

Well, remember, we want its relationship to the word
to continue unchanged until sometime after the
“31” mark. So we’ll copy the pose where it’s joined
up with the word (currently the word’s next-to-last
pose) over to around 40:

7. Select the “y’s” fourth pose; holding down the
Ctrl key, drag it to around 40, just a couple of
frames before the very last pose.

Now. Run the animation, sit back with a cold one
and survey your work. Ahhh, a job well done!
What?! The pause before the “y’s” fall is too long?
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Piece of cake — moving a pose along the timeline
adjusts the timing of the move:

1. Select the “y’s” last two poses (using the Shift
key to add the second one), and drag them to the
left some.

Why not render it to a wireframe movie? It’s only
about 45 frames. Or...

You could change the length of the animation! It’s
easy — you can use the pose scaling tool to resize
the length of all the lines at once:

2. In the Score window, drag a selection box
around all the poses except for the initial ones.

3. Set the Time Marker to the very first frame.

4. Select the Score window’s pose scaling tool (to
the left of the zoom tool).

5. Click and drag the last pose to the left or right.
Dragging right lengthens the animation, left shortens
it.

For extra credit you could:

• Add eases (in and out) where appropriate — at
the beginnings and ends of movements. Click and
hold on a pose nib to bring up the ease popup
menu.

• Adjust the path of the “y” as it catches up to the
word by adding poses. You could make it travel in a
circle by positioning the letter at a few key points
evenly spaced in time. Don’t forget — move the
Time Marker, then move the letter.

• Adjust the timing of the various segments. Select
the group of poses associated with a segment by
dragging a selection box around them, or by holding
down the Shift key while clicking on individual pose
nibs. Then drag them left or right, earlier or later in
time.

• Delay the scaling of the word until it reaches the
bottom. Hint: use Reset Scale from the Edit menu
on the pose at which the word reaches the bottom.

Organizing poses

Most of the time you’re dealing with poses you’ll
need to have the Score window’s Pick tool selected.
If you have the Zoom tool selected, the more you
click trying to select a pose, the more you’ll zoom in!
To zoom back out, hold down the Ctrl key while
zooming.

Whenever you need to alter poses, you’ll have to
click and drag on a pose, not near it.
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Creating a new pose — “freezing” an object

There are two ways to create a new pose for an
object:

• In the Score window, set the Time Marker to a
time in the timeline, then select the object and
adjust it in the project window.

• In the Score window, select the object, then hold
the Ctrl key down and click on a time in the timeline
for the object.

A new pose nib will appear in the Score window,
indicating a pose for that object at that time. This
ensures that the object will remain as it is at that
time, no matter what happens in the previous or
subsequent frames. (Just delete the pose nib to
allow the object to resume the pose implied by the
frame before and after.)

• Note: Using any of the tools in the Transform
toolbox on an object automatically “freezes” that
object into a pose.

If you want to allow an object to take on a pose
implied by poses before and after, all you need to
do is unfreeze the object. Just delete the pose from
the timeline. For example, deleting the third pose
above would result in a path something like the one
below right.

• Warning: Remember, the Delete key deletes
whatever you have selected in either the project
window or the Score window. Hitting Delete when
the project window is active will delete any selected
objects! Likewise, in the Score window hitting it with
an object selected deletes the object. However, with
a pose nib selected, the pose will be deleted, not the
object.

Selecting poses

To select a pose, just click on a pose nib on the
object's timeline. You can select multiple poses to
work on by dragging a selection box around them.
Holding down the Shift key while clicking on a nib
adds or removes it from the selection.

• Warning: When you select a pose you won't see
how the scene looks at that time. To do that you
must double-click on the pose (or hold down the

Pick Scale Zoom Play
pose animation
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Shift key while sliding the Time Marker, so it snaps
to poses). This moves the Time Marker to the time
of the pose.

Moving a pose — adjusting timing

Moving a pose is one of the most useful animation
features of Typestry. It provides an easy way to
change an object's speed.

You can move one or more poses anywhere along a
timeline by clicking and dragging them. Beware
though: moving one pose beyond another one can
play havoc with the already-established movements.

Consider the case of two poses that make an object
move from left to right in 24 frames. Let's say you
create a new pose at frame 12, halfway through the
animation. Then you move the pose to frame 20.
The object is still going to be halfway across the
screen in this frame (you haven't moved the object);
it will just take longer to get there — 20 frames
instead of 12. And the rest of the distance will be
covered in just four frames. So the object will
appear to move slower for the first half of the dis-
tance, and faster for the second half.

Remember: Click and drag on a pose, not near it.

Scaling poses — adjusting duration

You might want to stretch or squeeze the action in
a part of an animation. There are a couple of ways
you can do this. One is by dragging the beginning
and ending poses of the section out some, until they
run into other poses. However, there are tools to
stretch and squeeze in more interesting ways. You
can effectively resize just a portion of an object’s
timeline. The Time Marker acts as a reference point,
controlling how the resizing behaves — whether
one end is stationary while the rest of the line sec-
tion moves, whether the middle stays where it is
while both ends move, and so on. The farther from
the Marker a nib is, the larger its motion is. 

Here's how you do it. With two or more poses
selected: 

1. Select the Pose Scale tool in the Score window
(to the left of the Zoom tool).

2. Drag the Time Marker to the point around
which you'd like the line to scale.

3. Click and drag the poses along the timeline. This
will resize only the selected section of the timeline
without regard for points on the rest of the line.
This may mean that the selected poses expand out
beyond other ones.

-or-
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3. Hold down the Ctrl key while clicking and drag
the poses left or right. This resizes the selected por-
tion, and pushes out (or pulls in) the right-hand uns-
elected portion of the line (without scaling it) as
needed. The left-hand unselected portion is
untouched. The whole timeline’s length will change.
In other words, the selected poses expand out (or
in), moving some outer points out as well. This is
the “smart scale” mode.

If you'd like to change the duration of the whole ani-
mation, you can use the Animation Duration dialog
instead of using the Score window's Pose Scale tool
on all the poses. This allows you to use a single
number to adjust everything at once. Just select Set
Duration from the Motion menu. This brings up the
Set Duration dialog.

Set to. This scales the animation to a particular
number of frames.

Scale by. This scales the animation by a percentage. 

Align poses to frames. In scaling an animation,
when the individual poses move around they may or
may not line up on frame boundaries. Checking this
box forces each pose to align to the nearest frame.
The tradeoff for this convenience can be some sub-
tle changes in timing.

Duplicating a pose

Duplicating a pose is especially useful when you
want an animation to end up exactly where it start-
ed. To duplicate poses:

1. Select all the poses you want to duplicate.

2. Hold down the Ctrl key and drag one of the
poses to a new place on the timeline. This creates
copies of the selected poses and drags them all at
the same time.

Deleting a pose

To delete a pose, just select the pose, and hit the
Delete key.

Animation settings

You can customize the way the Score window
works with the controls in the Animation Settings
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dialog. This is available by selecting Animation
Settings from the Motion menu.

Frames/Second. This sets the number of frames
per second. You’ll want to adjust this based on
whether you’re going out to regular video, an AVI
movie, etc.

Jump by. This sets the number of frames by which
to jump when you use Jump Forward or Jump
Backward under the Motion menu.

Align Poses to Frames. With this on, pose nibs
and the Time Marker both snap to frame bound-
aries. Turning it off allows them to be between
frames.

Time Display. This determines the meaning of the
numbered tick marks in the Score window. The
default is Secs:Frames. This displays the current time
and frame number. For example, 3:17 means the

17th frame after the 3rd second. Unnumbered tick
marks are frames.

Rendering an animation

Typestry provides four ways to create an animation.

• You can see a simplified version of an animation
(one with boxes representing letters) within
Typestry.

• You can create a wireframe AVI movie.

• You can create an AVI movie the size and reso-
lution of the project window.

• You can create the AVI movie at a particular size
and resolution.

Additionally, you can output just frames to be
assembled later into an AVI movie, or for use in
some other application.

To view a simplified version of an animation within
Typestry:

1. Set the animation stoppers at the top of the
Score window to set the beginning and ending of
the animation.

2. Select Run Animation from the Motion menu. 
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3. Click in the window to stop the animation.

Typestry runs the animation in the Motion Drawing
Mode selected in the Preferences dialog. These
modes are:

Burn In. This draws each frame, one on top of the
other, beginning to end, creating a “trail” so you can
see the objects’ paths.

Loop Forward. This simply runs the animation
from beginning to end, over and over, until you stop
it.

Loop To and Fro. This runs the animation for-
ward, and then backward, over and over, until you
stop it.

Note: When Typestry animates objects on-screen, it
always displays the required frames as fast as it can.
For complex objects, this may be slower than you
expect; for simple objects it may be faster than you
expect. To see a “draft” of the animation at the right
speed, make a wireframe AVI movie (see below).

To create a wireframe AVI movie:

1. Select Make Movie from the Motion menu. This
brings up the Make Movie dialog.

2. Use the Browse button to select a directory, and
type a name in the Name box.

3. Select Wireframe as the Output Format.

(4. If you want just frames, without making a movie,
uncheck the Invoke Movie Maker choice.)

5. Click on the Build button.

Typestry then produces all the frames and puts
them in the directory you specified. Once all the
frames have been produced, the Movie Maker dialog
appears (unless you unchecked the Invoke Movie
Maker choice).
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6. In the MovieMaker dialog you should just be able
to click on the Build Movie button, unless you wish
to specify different First and Last Frame Bitmaps.
(For more on the MovieMaker see the next chap-
ter.) This brings up Video for Windows’ Video
Compression dialog.

7. Use this dialog to select and adjust the
Compression scheme. (See your Video for
Windows documentation for more on this.)

8. Click on OK. This begins the actual movie-mak-
ing process.

To create an AVI movie the size and resolution of the
project window:

1. Select Make Movie from the Motion menu. This
brings up the Make Movie dialog.

2. Use the Browse button to select a directory, and
type a name in the Name box.

Note: In Windows you must restrict the file name to
four characters. This is because Typestry appends
four more digits to identify the frame files. But if
you’re running NT there is no such restriction.

3. Select an Image Quality. You can use lower qual-
ity settings to make a quick “draft” of an animation.
Higher quality animations will take longer to render.
If you’ve set any lights to cast shadows, check

Compute Shadows to have them appear in the ani-
mation.

4. Select Project sized BMP Frames as the Output
Format.

5. If you’d like to render a subset of the frames, set
this in the Frames area.

(6. If you want just frames, without making a movie,
uncheck the Invoke Movie Maker choice.)

7. Click on the Build button.

Typestry then renders all the frames as BMP files
and puts them in the directory you specified. Once
all the frames have been rendered, the MovieMaker
dialog appears (unless you unchecked the Invoke
MovieMaker choice).

8. In the MovieMaker dialog you should just be able
to click on the Build Movie button, unless you wish
to specify different First and Last Frame Bitmaps.
(For more on the MovieMaker see the next chap-
ter.) This brings up Video for Windows’ Video
Compression dialog.

9. Use this dialog to select and adjust the
Compression scheme. (See your Video for
Windows documentation for more on this.)

10. Click on OK. This begins the actual movie-mak-
ing process.
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To create an AVI movie at a particular size and resolu-
tion:

1. Select Make Movie from the Motion menu. This
brings up the Make Movie dialog.

2. Use the Browse button to select a directory, and
type a name in the Name box.

3. Select an Image Quality. You can use lower qual-
ity settings to make a quick “draft” of an animation.
Higher quality animations will take longer to render.
If you’ve set any lights to cast shadows, check
Compute Shadows to have them appear in the ani-
mation.

4. Select Image Format sized Frames as the Output
Format. This allows you to use the settings found in
the Image Format dialog to determine the dimen-
sions, resolution, and file type of each frame. To set
or change these settings click on the Image Format
button to bring up the Image Format dialog.

5. If you’d like to render a subset of the frames, set
this in the Frames area.

(6. If you want just frames, without making a movie,
uncheck the Invoke MovieMaker choice.)

7. Click on the Build button.

Typestry then renders all the frames in the selected
format and puts them in the directory you specified.

Once all the frames have been rendered, the
MovieMaker dialog appears (unless you unchecked
the Invoke MovieMaker choice).

8. In the MovieMaker dialog you should just be able
to click on the Build Movie button, unless you wish
to specify different First and Last Frame Bitmaps.
(For more on the MovieMaker see the next chap-
ter.) This brings up Video for Windows’ Video
Compression dialog.

9. Use this dialog to select and adjust the
Compression scheme. (See your Video for
Windows documentation for more on this.)

10. Click on OK. This begins the actual movie-mak-
ing process.

The nature of Typestry animation

In Typestry, an animation is really a sort of a table,
like this:

Objects have a certain pose at each frame. If they’re
not in the table, they’re not in the animation. If they
are in the table, they’re in the whole animation.
They can’t be in the table in one frame, and not in
the table in another. This means that if you create
an object in a certain keyframe, you’ve created it for
the whole animation. Likewise, if you delete an
object in any keyframe, it’s gone for the whole thing.
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What to avoid

That having been said, here are a few things you
should avoid in an animation. They are all character-
istics that are permanently in place.

• Adding or deleting objects. An object exists (or
not) for the complete animation. Likewise, when
you group objects, they’re grouped for the whole
thing. If you want to make objects seem to disap-
pear, you can use a trick: shrink the object almost to
nothing in the space of a single frame.

• Changing any of the settings in the Details dialog.

• Changing anything in the Effects menu.

• Changing a light’s Look, color, or shadow-casting
ability. (But there’s a trick you can use to give the
illusion of animating a light’s Look and color. Read
on...)

What to remember

And speaking of lights, don’t forget — there are a
couple of things that you can play with and animate
to good effect: any light's position and intensity, and
any spotlight's coneangle as well. The Lights window
shows you the state of the lights at the time indicat-
ed by the Time Marker. Since you can animate inten-
sity, you can get the illusion of animating a light’s
color or Look using a trick. Use two lights in the

same position, each with a different color or Look.
Turn one’s intensity down and the other’s up. It will
look like one light, since they’re both in the same
place.

Tradeoffs

When you set some poses for an object, Typestry
moves the object through those poses using certain
tweening (interpolation) schemes. Think of this as
drawing curves through a series of points (poses).
Different animation packages use different kinds of
curves. Each has its advantages and disadvantages. 

The tradeoff with Typestry’s curves is that although
the curve goes through all the points so you can see
exactly where the object will be at a given pose, the
shape of the curve may not be exactly what you
want. Everything depends on the positions of the
various poses. Some situations may cause an object
to go through a point, and then beyond it, before
starting to curve around, rather than curving exactly
as it reaches the point. For rotations, sometimes you
may see a “preparation” for the rotation. Here the
object may rotate slightly the wrong way just before
it starts the real rotation.

If you notice any of these subtle idiosyncracies you
can fix the situation pretty easily. The general idea is
to identify the pose where things seem “off,” make a
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copy of that pose, and move it right next to the
original. The closer the better — one frame away
isn’t too close.

An animation checklist

If you think you need to establish a new relationship
between elements, you’ll probably need to group or
regroup things. Think about what needs to move
relative to what. Remember, when we say move, we
mean move, rotate, scale, skew, or any combination
thereof.

If you need to move something independently of
other things, try moving it out of the group it’s in.

If you need to move something in conjunction with
something else, try creating a new group that
includes both things.

If you need to delay an object’s movement, find the
pose where the delay should begin. Copy that pose
(using Ctrl-drag) to the time at which the delay
should end. The object won’t change between the
two poses.

If things are moving too quickly or too slowly, select
the affected poses and use “smart” pose scaling.

If you need to change the length of a whole anima-
tion, just select all the poses and use the Pose Scale

tool in the Score window to move them all at once,
lengthening or shortening the whole animation.

If things start too early or too late, just move the
pose(s) down the timeline.

If you need to reset an object’s orientation, scale, or
skew in the middle of things, just use one of the
Reset... functions under the Edit menu.

If you need to tweak the movement of a group, you
may benefit from creating a new group that includes
the one you want to tweak. Tweaking the new
group leaves the old one to act as it has been, so
you don’t have to go back and change other parts of
the animation.

Rendering a loop 

If you’re doing an animated loop you may have to
make a small adjustment to your animation. First of
all, you should have the first pose duplicated at the
end of the animation, so things end up where they
start. Now, when you go to render the frames, ren-
der all but the first frame, since it’s already duplicat-
ed at the end. This is especially important if you’re
using particles, wind, or motion blur.

• And remember: It’s not every piece of software
that allows you to do motion blur. If you can afford
the extra rendering time, be sure to turn this on: it
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creating a 2-frame animation

adds a powerful bit of realism. You’ll probably want
to use the Normal Blur setting (in the Motion Blur
item under the Effects menu) for an animation,
unless you’re shooting for an unusual effect.

Creating a 2-frame animation

To use particles or wind (Physical Simulation) in a
still image you must create an animation, since these
both depend on motion. However, you may need
only two frames to achieve the desired effect. In any
case, you should never need more than two poses.

When you use particles or wind, Typestry has to
calculate the position of the particles or the sheet in
every frame of the animation. For this reason, the
fewer frames you have, the smaller the number of
calculations that will have to be made, speeding
things up.

• This means that you should use the Animation
Settings dialog (available from the Motion menu) to
set a low number of Frames/Second. Two may be
sufficient — this will allow you to see things at inter-
vals of half a second.

1. With the Score window showing, drag the
object’s initial pose nib out. The farther you drag it,
the later in time the rendered frame will be.

2. Double-click on the pose nib you just dragged
out. This sets the Time Marker to that time.

3. Select Update Simulations from the Motion
menu. Typestry will then calculate things for that
frame. The more intermediate frames there are, the
longer this will take.

4. If you need to, move the pose nib to a different
time, double-click on it again to see the pose at that
time, and select Update Simulations again. Repeat
this until you reach a time that gives you the results
you like.

Danger, Will Robinson! To see the effect of the parti-
cles or wind in a given frame, you must select
Update Simulations from the Motion menu.
Otherwise, the calculations for the object’s shape
won’t get done.

5. Now you can render.

Viewing a movie

To view your animations you’ll need to use the
Media Player application. This is part of the Video
for Windows software, and is usually located in the
Accessories group in the Program Manager. The
hardest part of this process is remembering where
you had Typestry put the .avi file…



Click to open/close

Click and hold to show
Perfs menu

Drag bar: click and
drag to move in/out of
groups, up/down in list

Click and hold to show
Looks menu; click and
drag to copy Look to
another object

Click and type to edit name

Summary of Score window opera-
tions

• “First move the Time Marker, then move the
object. Move the Time Marker, then move the
object.”
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summary of score window operations

Zoom in;
+Ctrl key = zoom out

Pick tool

Pose Scale;
+Ctrl key = smart scale

Pose/ease type menu

Time Marker: shows
the time and frame
of the current view

Frame #

Play animation

Pose nib: click and
hold to show Pose
type menu; Ctrl-
click to create new
pose nib; Ctrl-drag
to copy nib

Animation brackets
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Font: PIXAR is one character custom
designed in Fontographer; Impact for
Typestry 2.0; PixarPerfs for back-
ground

Build Method: Extrude with custom
bell-curve-shaped bevel, bevel depth
100%; for background, default
Extrude

Text Look: Faces of text are
BumpWave\Calmwave\beach, sides
are Combinat\asteroid\foil; back-
ground is Material\Starter\water\
Deep Ocean Water

Lights: #1, Blue 70%, #3 Red 70%,
#4 Yellow 70%, #7 pink 70%, #9
Dark blue 70%, #10 50%, #14 50%,
#16 50%, "E" 45%

Image: John Bennett
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